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Introduction 
The S.I. Photonics 400 Series Spectrophotometers are laboratory instruments 
that utilize the latest solid state CCD array detector technology.  The optical 
system is specifically designed to be used with fiber optic probes for sampling.  A 
variety of probes and probe configurations are available for different sample 
requirements.   

The instrument consists of tungsten and deuterium (model 420 and 440) light 
sources, optical shutters for the light sources, a spectrograph with integrated 
CCD array detector, and the detector control electronics.   

The tungsten source is part of the main power supply printed circuit board.  The 
lamp is a miniature quartz-halogen type.  The lamp output is optically regulated 
using a photodiode detector and feedback circuit.  The lamp power supply also 
features over-current protection during lamp start-up and operation.  The 
tungsten lamp is used for the 350 to 980 nm wavelength range when the 
deuterium lamp is not used and from 460 to 980 nm when the deuterium lamp is 
used.   

The deuterium lamp is a high output and long life unit capable of 4000 hours of 
operation.  The lamp bulb is pre-aligned to a flange, which makes changing the 
lamp a simple operation.  The lamp power supply and ignition functions are 
performed under software control so that the lamp is turned on only when 
needed for acquiring data in the 190 to 460 nm range.   

The spectrograph is a sealed, all-reflective optics system that uses a single 
mirror for collimating and focusing, and a 325-line/mm diffraction grating blazed 
at 300 nm.  An integrated, fixed order-sorting filter is used to eliminate second 
order diffraction.  The spectrograph optics, CCD array detector, and detector 
electronics are housed in an insulated, temperature regulated enclosure to 
ensure high baseline stability.   

A digital signal processor is used in the 400 series instrument to execute the 
commands issued by the host computer.  This very high speed 24-bit processor 
directly generates the timing states necessary for CCD readout, sums the data 
from multiple CCD reads, and controls other devices in the spectrophotometer 
such as optical shutters and deuterium lamp power relays.  The processor has 
an integrated serial communications interface that is used to transfer command, 
status, and data information between the spectrophotometer and the host 
computer.   

This User's Manual covers the installation, use, and maintenance of the S.I. 
Photonics 400 Series Spectrophotometers.  It is valid for models 410, 430 
(tungsten lamp source only) and 420, 440 (tungsten and deuterium lamp 
sources).   
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Items Included in 400 Series Systems 

Basic items shipped with your instrument are listed below, see the packing slip 
for a detailed list. 

1)  Spectrophotometer  

2) Fiber optic sampling accessory  

3)  AC power cord 

4)  6' long DB9M to DB9F RS-232 cable  

5)  Software installation CD including manual and tutorial 

6)  Trimpot adjustment tool 

7) Hex wrenches (2) 

8) Spare tungsten bulb 

Verify the contents of the shipping container and notify S.I. Photonics if any items 
are missing.  We can be reached at (520) 293-6911 or via the internet at   
www.si-photonics.com 
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Technical Assistance, Service, and Spare Parts 
If it is necessary to contact S.I. Photonics for support, please have ready the 
instrument model number, serial number or optics serial number and control 
software revision number.   The About Spectrometer window accessed from the 
Help menu contains much of this information.  Print out a copy and keep on file 
for future reference. The model and serial numbers can be located on labels 
affixed to the inside of the instrument base.  The software revision number is 
printed on the distribution CD label and can also be found in the View menu of 
the main front panel under VI info. 

 
Figure 1-1:   About Spectrophotometer Window 

 
Replacement parts for the 400 Series Spectrophotometers are: 

 Part Number                           Description   
1991   Lamp, Tungsten, Quartz 

1103   Lamp, Deuterium 

The tungsten lamp is part number Thorn M29 (product no. 72170T) distributed by 
Microlamp, Ft. Lauderdale, Florida and may also be purchased directly from 
them.  It is recommended to have a spare tungsten lamp. 

For technical support and to order supplies and replacement parts contact the 
Service Department at (520) 293-6911 or via email at support@si-photonics.com. 
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Safety Message 

 

 

CAUTION! 
It is necessary to remove the cover of the 400 
Series Spectrophotometer for some procedures 
described in this manual.  In some cases, power 
to the instrument must be applied while 
adjustments are made.  There are two regions of 
the instrument power supplies that are shielded 
and marked where dangerous voltages exist.  
Avoid touching any components behind these 
shields.  If the shields are removed for any 
reason, re-install them before power is applied 
to the instrument.   
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Quick Installation Instructions 
This section is for those who either enjoy the challenge of setting up a new 
instrument without reading the manual, or do not have the patience to read a 
manual thoroughly before plunging in.  If you are this type of person, and you 
have experience installing scientific instruments and Windows software, read this 
section to get up and running quickly.  Then, when the excitement has worn off or 
you get stuck, go back and thoroughly read the manual.  For those persons that 
are more cautious, read the manual Sections 2.2 through 2.4, then follow the 
instructions to get the instrument operational before continuing with the detailed 
software description.  A tutorial video CD is also available that covers various 
topics including instrument setup and software features. 

Before you plug in AC power to the instrument, remove the cover by loosening 
(not removing) the four screws on the ends.  If you are using 220VAC power, the 
power selection switch (located near the main power switch on the main power 
supply board) must be switched and the fuse value changed.   

If equipped with a probe, install the probe holder by sliding it onto the probe 
stand and install the fiber optic probe next.  Make sure that the ends of the fiber 
connectors are clean (wipe with alcohol and lens paper), and that the SMA 
connectors are plugged into the correct locations.  A nylon-tipped setscrew is 
used to hold the connector ferrules in the sleeves.  Tighten the setscrews using 
the supplied hex (Allen) wrench.  Replace the cover on the spectrometer and 
attach the AC power cord.  Connect the RS-232 port on the spectrometer to an 
unused port on the host computer.  An RS-232 to USB converter accessory is 
available for systems lacking an available serial port. 

When the Control Software CD is loaded Windows should automatically begin 
the installation process.  If the install does not start automatically, execute the 
SETUP.EXE on the CD-ROM and follow the directions.  

Once installation is complete, start the SI400 application and turn on the 
spectrophotometer power.  The tungsten lamp should immediately light, but the 
deuterium lamp (Model 440 and Model 420 instruments) will not light until 
commanded by software.   

Click the OK box to initialize the instrument. If the instrument is not 
communicating with the host computer, an error message will pop up. To correct 
the error, pull down the Operate menu from the main screen and click on the 
Configure option.  

Select the COM port that you are using on the computer.  Leave the baud rate 
set to 38,400 as the spectrometer is shipped with this baud rate. Choose printer 
type, Monochrome or Color. Click the Save button to keep any changes, and 
then select from the Operate menu the Initialize item.   
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At this point, if everything has gone just right and the computer and 
spectrophotometer are communicating, you should hear a faint click-clack from 
the tungsten lamp shutter confirming communication.  Also, the Blank button in 
the upper right corner of the screen will change from a light gray inactive mode to 
a red active mode.  The Setup file is automatically read from the hard drive and 
the operating parameters of the spectrometer will be set.  The parameters 
include the wavelength range and the lamp crossover wavelength.  The 
wavelength scale on the main spectrum display will reflect the wavelength range.  
At this point, the wavelength range and lamp crossover wavelength can be 
changed if desired by selecting the Wavelength Range item, which is located in 
the Operate menu.  If you have a Model 440 or Model 420 instrument and 
choose a wavelength that is below the lamp crossover wavelength, you will be 
asked to turn on the deuterium lamp.   

If you get error messages instead at this point, follow the advice of the error 
messages. 

Once the spectrophotometer is operating, immerse the probe in water, and start 
pushing buttons.  The Blank takes a blank spectrum, and Sample takes a 
sample spectrum and records the results on the screen.  Most of the buttons are 
self-explanatory in the usual Windows fashion.  The Quantitative Item in the 
Operate menu, loads the quantitative analysis feature.  The Timed Acquisition 
item in the Operate menu opens a new screen where entire spectra, discrete 
wavelengths and kinetics can be acquired at set time intervals. The Multi 
Spectra Display item can be accessed from the View Menu allowing up to 10 
spectra to be viewed and manipulated. 

When you are ready for more detail, read Sections 3.1 through 4.4.  This way 
you will be able to use the software to its fullest capabilities, and change lamps 
and adjust lamp intensity when the need arises. 
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Setup of the 400 Series Spectrophotometer 
The 400 Series Spectrophotometer includes a fiber optic probe that is not 
connected during shipment.  It is necessary to connect the probe in order to 
conduct the initial system tests.  The probe stand and sliding probe holder is 
designed to conveniently hold the probe when it is not in use, or when sampling 
the contents of small containers. It is not essential for the operation of the 
spectrophotometer and may be removed if desired. 

Removing the Cover 

The spectrophotometer cover must be removed to install the probe.  Before 
starting, make sure that the AC power cable is disconnected where it enters the 
instrument.  Next, locate the four cover screws, two on each end of the 
instrument.  Using a Phillips screwdriver, loosen the four screws approximately 5 
turns, or 1/8".  The screws should not be removed.  Next, lift the cover straight 
up until it clears the internal components, and 
set it aside.   

 

 

 

 

 

 

 

 

 

 

 
 

 

Figure 2-1:   Main compartment of the 440 Series Spectrophotometer 
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Inside the Spectrophotometer 

Inside the spectrophotometer is a compact spectrograph (which is thermally 
insulated for temperature stability), a digital electronic controller card, and the 
main and optional deuterium lamp power supplies as shown in Figure 2.1. 

Initial Inspection 

With the cover removed, inspect the inside of the spectrophotometer for any 
parts that may have vibrated loose during transit. 

AC Voltage Selection 

The spectrophotometer is configured to operate from 100 to 120VAC mains 
when delivered from the factory.  If the instrument is to be operated from 220VAC 
mains, the AC voltage selection switch must be changed.  This switch is located 
beneath a guard near the power switch.  The switch is accessible through a hole 
in the guard.  A small flat blade screwdriver is used to change the switch setting.   

Installation of Probe Holder  

To install the probe holder on the probe stand rod, squeeze the flat metal spring 
stop slightly and slide it first over the rod end with the black plastic surface on 
top. 

Installation of Fiber Optic Sampling Accessories  

All sampling accessories for the 400 Series Spectrophotometer are fiber optically 
coupled to the instrument.  Each accessory will have either two (UV only or 
Visible only) or three (UV/Visible) fiber optic connectors.  The standard probe 
supplied with the 400 Series instrument is a fiber optic dip probe.  Also available 
with the instrument is the Universal Fiber Optic Sampling Bench, which can be 
fitted with a cuvette holder or optical filter holder, or a fiber optic reflectance 
probe. 

The 400 Series instruments are designed to be used with probes terminated with 
standard SMA type connectors, such as the standard fixed path length dip 
probes.  The connectors are not attached to the instrument in the conventional 
manner of tightening the retaining nut, but rather the connector ferrule is clamped 
in place using a nylon-tipped setscrew.  This approach was taken to ensure a 
more mechanically stable connection.  It is important to use only the supplied 
nylon tipped setscrews to clamp the connector ferrules.  Standard setscrews will 
damage the ferrule, and possibly break the fiber inside the connector. 

Fiber optic probes are fragile in some operations.  Use caution with the probe as 
damaged probes cannot be easily repaired; replacement is usually the only 
alternative.  The fiber optics in the probe are fragile and can be broken if 
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mishandled by placing excessive tension stress, by exerting too small of a bend 
radius on the cable sheath, or by kinking or crushing the sheath.  Never swing 
the probe from the fiber optic sheath, or pull on the probe when attached to the 
spectrophotometer such that the sheath is stretched tight. 

Fiber Optic Probe Installation 

The fiber optics at the connectors must be clean, free of dust and especially 
fingerprints (to avoid UV absorption) before they are installed.  Use lens tissue 
moistened with isopropanol to clean if necessary.   

To install any of the sampling accessories, locate the small hex (Allen) wrenches 
provided with the instrument.  Remove the plugs in the spectrometer where the 
fibers attach, and remove the caps from the ends of the fiber optic ferrules.  Take 
care not to scratch or damage the ends of the fiber optics when the protective 
caps are removed.  Insert the W source fiber into the W source bushing until it 
stops and secure it with the setscrew.  Install the Input fiber (and for Model 
420/440 instruments, the D2 source fiber) in the same manner. 

RS-232 Communications Link   

The communications channel between the host computer and the 400 Series 
Spectrophotometer is an RS-232 serial link.  Information passed over this link 
includes commands to operate light shutters, initiate the CCD array detector 
readout, turn on or off the optional deuterium lamp, etc.  The link is also used to 
pass the light intensity as a function of wavelength information used to determine 
the optical transmission or absorbance of a sample.  One important task for the 
communications link is to initialize the spectrophotometer by passing a software 
program to its microprocessor.  This task must be accomplished before the 
spectrophotometer can recognize any commands or perform any functions.   

Configuring the Communications Link 

In order for the communications link to pass information, it must be properly 
configured involving both the physical cabling of the host computer COM port to 
the spectrophotometer, and ensuring that the two pieces of equipment are 
communicating at the same data rate, or baud rate.  All other communications 
parameters, such as number of data bits, parity bits, etc. are permanently 
configured in the spectrophotometer, and are configured in the host computer by 
the SI400 application without the need for user intervention.   

RS-232 Cable  

The communications cable must be a high-quality, shielded cable intended for 
RS-232 use, such as the one supplied with the instrument.  This is especially 
critical when higher baud rates (19,200 and higher) are used.  The cable supplied 
with the 400 series instruments is a 6' DB9 male to DB9 female, wired straight 
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through (pin 1 to pin 1, pin 2 to pin 2, etc.) which can be connected to a DB9 
male COM port connector on the host computer.  A DB25 female to DB9 male 
adapter is also supplied to allow connection to a DB25 male serial port on the 
host computer.  It is possible to use a longer cable; however it may be necessary 
to use a lower baud rate to ensure reliable communications.   

Connect one end of the cable to the spectrophotometer and the other to any 
unused COM port on the host computer configured as COM1, COM2, COM3, or 
COM4.  If all COM ports on the computer are in use, it may be necessary to add 
a COM port connector or interface card.  It is important that the COM port to be 
used is not sharing an interrupt.  Refer to your computer equipment supplier for 
information.   

Baud Rate Selection 

It is advantageous to use as high a baud rate for the communications link that 
reliably works as spectral data will be transferred from the spectrophotometer 
and be displayed or analyzed faster.  Under some conditions it may be 
necessary to decrease the baud rate to ensure reliable communications with 
some host computers.   

The COM ports for most modern PC compatible computers are capable of 
reliable operation at baud rates of at least 19,200 if the cable length is kept short.  
If it is necessary to use a cable of approximately 15' or greater between the host 
computer and the spectrophotometer, or if an older PC computer that can not 
support 19,200 baud is used, it will be necessary to decrease the baud rate to 
9,600.  If the host computer is capable of communicating at 38,400 baud or 
higher, and only the 6' cable supplied with the instrument is used, it may be 
advantageous to increase the baud rate.   

The baud rate for the 400 Series Spectrophotometers is set to 38,400 at the 
factory.  With a 16550 UART serial port, baud rates up to 57,600 are possible 

To change the baud rate, it is necessary to remove the cover of the 
spectrophotometer (Refer to Section 2.2, Removing the Cover) and change the 
baud rate jumpers.  The jumpers are on the controller board near the RS-232 
connector.  There are 3 pairs of pins emerging from a small block labeled JP1, 
JP2, and JP3.  A plastic plug containing a wire fits down over a pair of pins 
electrically connecting them (Closed or 1) or is removed or pushed down over 
only one pin (Open or 0).  Select the desired baud rate by positioning the 
jumpers as shown in the Table 1 below.  This table is also printed on the 
controller board near the spectrograph. 
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Table I: Baud Rate Jumper Table 
 
 
 
 

 

 

 

Figure 2-2:  Configuration Drop Down Menu 
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BAUD Rate 

0 0 0 9600 

0 0 1 19200 

0 1 0 38400 

0 1 1 57600 

1 0 0 115200 

1 0 1 230400 

1 1 0 460800 

1 1 1 921600 
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Spectrograph Warm-up 

At this point, the spectrophotometer cover is ready to be replaced.  Follow the 
cover removal procedure in reverse order and then connect the AC power cord 
supplied to the instrument and to a standard 110VAC wall outlet.   

The spectrograph in the 400 series instruments is temperature regulated at 
approximately 35ºC to improve baseline stability.  A warm-up time of 
approximately 30 minutes is required for the temperature of all optical elements 
to equilibrate.  During this time, the baseline will drift.  If careful measurements 
are to be made, or if long periods between blank and sample acquisition are 
anticipated, temperature equilibration and warm-up is essential. 
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Computer Requirements 
The host computer using the SI400 Series application software controls the 400 
Series Spectrophotometer.  This software system operates in the Windows 95 or 
later environment and conforms to normal Windows operating conventions 
whenever they apply.  Users unfamiliar with the Windows environment should 
refer to the "Getting Started with Microsoft Windows" and "Microsoft Windows 
User's Guide" that is part of the Windows distribution package before proceeding.   

Host Computer Hardware and Software Requirements 

The SI400 control application runs under Windows 95, 98, NT, 2000 and XP 
operating systems.  Minimum hardware requirements include: 

1) a Pentium 90 CPU 

2) a hard disk drive with a minimum of 6 MB free space 

3) a CD-ROM Drive 

4) a two-button mouse (or a three button mouse in two-button mode) 

5) 32 MB RAM  

6) one RS-232 serial port equipped with a 16550 buffered UART configured as 
COM1, COM2, COM3, or COM4 using the standard Windows addresses 
and interrupt vectors.  The port can have either a DB9 or DB25 male 
connector.  

 **Alternatively, an RS-232 to USB conversion cable is available for PC 
configurations utilizing USB input. 

A VGA monitor with a minimum 800 X 600 resolution is required.  

Throughout this manual, a basic knowledge of the Windows environment and its 
conventions is assumed.  If necessary, refer to the Windows User's Manual for 
guidance.   

Installing the SI400 Control Software 

The SI400 Control Software is distributed in compressed form on a CD-ROM.  
The files must be installed onto your hard disk drive using and Setup program on 
the CD-ROM from Windows.  Disks can be made from the CD-ROM – Call S.I. 
Photonics for instructions.  To install, insert the CD-ROM into your drive.  The 
install set-up window should open automatically, if not, go to the Start Menu and 
click on Run. Type in CD-ROM drive designation (i.e. D: ) A window will appear 
Click on SET UP.  Press the Install button and follow the prompts to install. 
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Lamp Adjustments 
The tungsten source used in the 400 Series instruments is a 10 watt quartz-
halogen lamp with approximately 3100ºK filament temperature.  Its average life 
expectancy is over 200 hours (longer life, lower output lamps are available; call 
S.I. Photonics for information).  The deuterium source is a high-intensity, pre-
aligned lamp with an average life of 4,000 hours.  Both lamps need to be 
periodically replaced as normal instrument maintenance.  The tungsten source is 
replaced only when it fails.  The deuterium source is replaced whenever the 
estimated operating hours exceeds its lifetime, or when the lamp intensity and 
stability are unacceptable.   
 
Use care in replacing both tungsten and deuterium lamps as the lamp envelopes 
are fragile and can break during handling.  Also, both lamps and their lamp 
housings become extremely hot during operation.  Allow them to cool before 
disassembling.  Finally, the deuterium lamp outputs ultraviolet radiation that is 
harmful to eyes and skin.  Observe the precautions on the replacement lamp, 
and protect the eyes with plastic safety glasses designed to absorb UV light if it 
is necessary to view the lamp during operation.   

Adjusting Lamp Intensities 

Any time the tungsten or deuterium lamps are replaced or adjusted, or the fiber 
optic probe is changed on the spectrophotometer, it may be necessary to adjust 
the lamp intensities such that the minimum detector integration time is used, and 
the CCD detector does not become overexposed.  This is accomplished by lamp 
intensity adjustment screws that prevent a portion of the light from the lamps 
from reaching the fiber optic probe input.  

During all lamp intensity tests and adjustments, the fiber optic probe used with 
the spectrophotometer should be installed and sampling a "blank".  If a dip probe 
is used, it should be immersed in a blank solution.  If a reflectance probe is being 
used, it should be pointed towards a white reflectance standard or shiny 
aluminized surface.  The reflectance probe rarely needs the light reduced. 

To adjust the lamp intensity, the AC power must be disconnected and the 
spectrophotometer cover must be removed.  Next, the main power must be 
reconnected while the cover is removed.  Care must be taken to not touch any 
electrical components under or near the guards on the main power supply 
or the deuterium lamp power supply as high voltages exist in these 
regions.  Also, avoid dropping tools or other metal objects that could cause 
electrical shorts in the spectrophotometer electronics.   
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Figure 2-3:  Lamp Adjustment 

Switch on the spectrometer power and initialize.  There is a lamp adjust utility 
that is accessed from the Configure option from Operate menu.  Once the 
spectrometer is initialized, two additional buttons on the Configure screen 
become active for adjusting the deuterium and tungsten lamps.  When pressed, a 
lamp adjustment window appears displaying a 
bar scale that monitors the intensity of the 
particular lamp.  The bar is blue when the 
intensity is too low, green when it is in an 
acceptable range, and red when the intensity is 
too high. Locate the appropriate lamp intensity 
adjustment screw and adjust the lamp so that 
the bar is closest to the top of the bar scale 
while it is still green. At this point, the lamp 
intensity should be adjusted such that the 
detector is never over ranged, yet a minimum 
acquisition time is required.   

 

Deuterium lamp intensity 
The same Allen wrench used to lock the fiber 
optic probe ferrules in the spectrometer is used 
for the intensity adjustment screw.   The 
adjustment screw is self-locking, and is 
somewhat more difficult to turn than the probe setscrews. Turn the screw in or 
out to adjust the intensity. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 2-4:  Deuterium lamp intensity adjust

Lamp intensity 
adjustment screw 

Fiber optic clamp screw 
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Tungsten lamp intensity 
The tungsten lamp intensity is adjusted by rotating a flag into the path of the lamp 
output. The exposure is very sensitive to the flag rotation. The hex head 
adjustment screw will rotate the flag; a correct size hex wrench was supplied with 
the instrument. The flag should have enough rotating resistance to stay in place.  

 
Figure 2-5:  Tungsten Lamp Adjustment Flag and Screw 

 

Tungsten Lamp Replacement 

Touching the replacement lamp envelope with the hands during installation can 
cause premature failure.  Replacement lamps are shipped with a plastic or paper 
cover over the envelope to protect them from being touched.  Do not remove this 
cover until the lamp is installed in the socket, and ready for installation in the 
lamp housing.  If the lamp envelope is accidentally touched, clean it with 
absorbent lens tissue moistened with isopropyl alcohol. 

Intensity adjustment screw 

Adjustment flag tension 
screw (no adjustment 
necessary) 
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The AC power must be disconnected and the spectrometer cover must be 
removed. The tungsten lamp housing on the main power supply circuit board, is 
located to the left of the main power supply transformer. The tungsten lamp is 
retained in the housing with a spring-loaded clamp.  Grasp the clamp at the hook 
in the clamp stem between the two springs and lift straight up to release. 

 
 

Figure 2-6:  Tungsten Lamp Housing Location 
 

Grasp the lamp socket leads and pull the lamp socket from the housing.  Pull the 
lamp from the socket and discard. 

Install the replacement lamp in the socket, remove the protective cover, and then 
set the lamp into place in the housing while again pulling up on the clamp.  
Before releasing the clamp, make sure that the lamp is properly seated in the 
housing such that the bulb is not damaged.  Gently release the clamp to secure 

Lamp socket (shown 
partially removed) 

Clamp (shown lifted) 

Fiber optic 
locking setscrew 

Lamp Housing 

Lamp current indicator 
Lamp current 

adjustment trimpot 
Shutter/photodiode mount
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Adjusting Tungsten Lamp Current 

In the event that the tungsten lamp may need adjustment or is removed and re-
installed for any reason, the lamp current set point must be adjusted.  This is 
performed by adjusting a trimpot until a LED indicates the proper lamp current.  
The lamp current is adjusted with the spectrometer cover removed, and power 
applied.  Make sure that the tungsten lamp is illuminated and the deuterium lamp 
is off before proceeding.  Locate the lamp current adjustment trimpot and the 
lamp current indicator LED.  Use a trimpot adjustment tool to turn the trimpot 
clockwise until the LED is illuminated.  Next, turn the trimpot counterclockwise 
until the LED just becomes fully extinguished.  When the lamp current indicator is 
not illuminated, the lamp current is being regulated at the correct level by an 
optical feedback circuit.  

This trimpot is NOT meant for adjusting the lamp intensity.  Before placing the 
unit in service, if necessary adjust the lamp intensity.   

Deuterium Lamp Replacement 

The AC power must be disconnected and the spectrometer cover must be 
removed.  Locate the deuterium lamp electrical connector near the right side of 
the lamp power supply transformer. There is a latch on the right side.  Press the 
top of the latch towards the connector body to release it, then pull straight up on 
the connector to detach it from the printed circuit board.  

The deuterium lamp is held in its housing by two screws located on top of the 
lamp mount.  Use a small, flat blade screwdriver to remove these two screws.   
The lamp can now be lifted from the spectrometer and disposed.  Install a new 
lamp by reversing the procedure above.  No optical alignment is necessary.   

If necessary before placing the unit in service, adjust the lamp intensity.
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Figure 2-7:  Deuterium Lamp Housing and Electrical Connector 

 

Lamp Warm Up Times 

Both tungsten and deuterium lamps require a warm up period of approximately 1 
hour before they reach maximum stability, but for routine use, 30 minutes may be 
sufficient.  The lamp warm up time is independent of the time necessary for the 
spectrograph temperature to stabilize.  This is especially important to remember 
if the deuterium lamp is not turned on when the instrument is first powered up.  If 
either lamp has not had sufficient warm up time, baseline drift will be observed. 

Connector Latch

Lamp mount 
screws 

Lamp intensity 
adjustment screw 

Fiber optic clamp screw

Deuterium lamp 
electrical socket 

Deuterium lamp 
electrical connector 
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Software Overview 
 
Introduction 
 
The SI400 Control Software uses the Virtual Instrument (VI) concept where the 
various buttons, knobs, dials, displays, and controls that you would expect to find 
on an instrument, along with pull down menus, have been replaced by their 
graphical equivalents that appear on the computer screen.  The instrument 
hardware no longer has physical controls, but the combination of computer 
screen, keyboard, and mouse has replaced their function in ways that can be 
easily optimized for specific tasks.  The SI400 applications have different front 
panels for general data acquisition, quantitative data acquisition, and for 
acquiring data at fixed time intervals, each optimized for the specific task.   

During installation a program group was created and can be accessed in 
Windows 95/98/NT/2000 and XP from the Programs item on the Start menu. To 
start the application, SI 400 program group icon, then double click on the SI400 
application icon.  If you do not select to have a program group created, execute 
the SI400.exe program using the file manager.   

When the SI400 application is started, it presents the main VI front panel that 
appears (see Figure 3-1 Main front panel) to have an assortment of buttons and 
other digital controls and drop down menus, along with a graphical display of 
optical absorbance, transmission or reflectance.  The buttons are "pressed" by 
using the mouse to point to the button, and pressing the left mouse button.  If a 
button is active, it will react when pressed so that it looks like it was pressed, and 
that some activity is being performed.   

There are times when a button cannot become active until some other function is 
first performed.  For example, the Blank button is inactive until the instrument is 
initialized.  The Sample button is inactive until a blank has been acquired.  When 
a button is inactive, it is a light gray, semitransparent color.  
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System Overview: Main Panel 
 
In this section the various features of the 400 Series Control Software are 
demonstrated.  The figure below shows a graphical representation of the front 
panel with each feature identified.  At this point it is advisable to acquire both a 
blank and a sample spectrum so that you can evaluate each feature as they are 
presented. 
 

 
Figure 3-1: SI400 Control Software Main Panel 
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Measurement Unit Allows the user to toggle between measurement 
modes including Absorbance, Transmittance, 
Reflection and Intensity. Since the raw data is stored 
in memory, the units can be mathematically 
adjusted after the acquisition.  

 
Sample Once a blank has been acquired the sample button 

becomes active and sample measurements can be 
acquired.  A full spectrum acquisition is 
automatically presented in seconds. 

 
Blank Allows for the establishment of a baseline for 

subsequent sample measurements. 
 
Lock Blank Locks the blank button so that the current baseline 

cannot be accidentally overwritten. 
 
Restore Full View Restores current graphical display to the original 

aspect ratio as demonstrated when the sample was 
acquired.  This feature is used to return to normal 
view if a zoom feature or different scaling was used. 

 
Y Scale Restore Restores display to the original Y-scale displayed 

when the sample was acquired.  This feature is 
useful if a zoom or different scaling were used. 

 
 
 
Reference Spectrum Allows for two spectra to be viewed and one is 

designated as a reference.   Deviations between 
samples can be ascertained using this feature. 

 
 
 
 
 
 
Peak Smoothing Smoothes displayed data using a Savitzky-Golay 

quadratic-cubic algorithm with an adjustable number of 
points.  This effectively increases the signal to noise 
ratio of spectral data at the expense of reduced spectral 
resolution.  Data saved to disk files is not saved in 
smoothed form, but any file read from disk can be 
smoothed.  The smoothing algorithm is described in J. 
Anal. Chem., 1964, 36, p. 1627.   

 
UV Lamp Turns on or off the deuterium lamp.  The lamp power 

supply requires approximately 20 seconds to ignite the 
lamp discharge.  The lamp should be allowed to warm 
up for at least 20 minutes to reach maximum stability.  
Baseline drift will be observed if the lamp has not had 
time to stabilize.   
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Peak Find Opens a new front panel for automated peak and 

valley analysis.  Push the Close button to return to 
the main front panel.  Function Key F4 

Blue Cursor Adds an entry into the wavelength column of the 
Data Table at the current position of the blue 
cursor. 

Red Cursor Adds an entry into the wavelength column of the 
Data Table at the current position of the red cursor. 

Update Table Updates the absorbance, % transmission, % 
reflectance or intensity fields in the Data Table.  
Used when wavelengths are manually entered in 
the Data Table rather than using the blue cursor/red 
cursor buttons. 

Clear Table Clears the Data Table. 

 

 

 

λ Table The wavelength table is useful when referencing 
specific or multiple wavelengths for analysis.  
Users can manually type the desired wavelength 
into the table and depress the Update Table 
button to retrieve the information. 

 Alternatively, users can drag the blue and red 
cursors to the desired location and depress the 
Blue Cursor and Red Cursor buttons to update 
the table with those specific coordinates. 
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File Name Indicates the file name to which the current spectrum will be saved. 

Comment This field allows users to enter specific information and experimental conditions 
about a sample. 

Operator Allows for the entry of a user name indicating the name of the analyst. 

Blank Indicates the date and time when the last blank spectrum was acquired. 

Info Table Allows users to enter specific information about a spectrum. 

Date & Time Displays the date and time the current spectrum was acquired. 
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Graphical Display Displays the current spectrum on the monitor.  X-axis consists of 
wavelengths while the Y-axis indicates the measurement mode. Users 
can select either a blue or red cursor for assistance in identifying specific 
spectral features.  Zooming can be accomplished by directly editing the 
max/min labels on the axes’ of the graph.  Clicking on the max or min 
label on either axis and editing it to the desired value does this.  The tic 
marks will automatically be adjusted. 

 A right mouse click allows for changing of display views. 

 

Cursor Indictor The cursor position indicator is located just above the graphical display 
and identifies the wavelength and intensity.  Users can choose either blue 
or red cursor mapping. The small square indicator changes from white to 
black indicating which cursor is currently enabled.  An icon consisting of 
the cursor intersection within a small white box is a control that allows 
changing various cursor display attributes such as a cursor or no cursor.  
Clicking on this will bring up a menu of selections.  An icon that appears 
as a padlock to the right of the attribute control is a control that forces the 
cursor to be constrained to the displayed data points, or free to move 
anywhere on the display.  

The four-diamond triangle located immediately to the right of the cursor 
position indicator allows for single step incremental scrolling of the 
cursor currently selected as indicated (↑) by the darkened box.  
Depressing the right mouse button allows users to hide the cursor 
indicator.  
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Graphic Control The graphic Control allows for 

modifying the appearance of the 
displayed spectrum.   

 
 

 
 
Axis Lock The X and Y buttons on the left side of the Graphic Control 

permit locking of either axis.  When selected, the X an Y axis will 
no longer autoscale with successive spectrum acquisitions but 
instead will remain fixed at the established values.  If autoscaling 
is turned on, the display scale will be adjusted to the data 
whenever the display is updated (such as when a new spectrum is 
acquired).  When autoscaling is turned off, the display scale will 
remain constant during data acquisitions. 

 
 
 
Display Units X.XX and Y.YY buttons allow users to select the desired display 

units, significant figures, etc. 
  
 

 
Zoom The zoom button allows users to select the between a variety of 

zoom options. 
 
 
 
 Zoom Region User selects a defined zoom region 
 
 

  
 Zoom Wavelength Region User defines the wavelength 

region to be zoomed 
 
 
 Zoom Y-Axis Region User selects the defined y-axis 

region to be zoomed 
 
 
 Zoom Restore Returns graphical display to it original size 
 
 
 Zoom In Stepwise Permits stepwise zooming in of a selected 

region 
 
 

 Zoom Out Stepwise Permits stepwise zoom out of selected 
region 
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Panning  Allows users to pan around the Graphical Display 

 
 
 

Cursor Select Allows users to select either the blue or the 
red cursor  

 
 

 
Delta X Displays the wavelength difference between the 

two cursors. 

 

Delta Y Displays the intensity unit difference between the 
two cursors. 
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Drop Down Menus 
This section summarizes the features for functions accessible from the drop down menus. 
 
File Menu 
 

Open  Loads a previously saved spectrum and 
  dataset. Function Key F6 or Ctrl+O 

 
Save  Saves the current spectrum and dataset. 
  Function Key F7 or Ctrl+S 

   
Save As Saves the current spectrum and data set 

as either a text or an Excel file format. 
 

Auto Save Automatically saves each successive 
spectrum and dataset to a selected file 
in the *.SIS format. 

 
Auto Save As Automatically saves each successive 

spectrum and dataset as either the default *.SIS format or as a 
*.TXT format. 

 
Export Exports a single file or group of files that have been saved on the 

disk to an Excel or delimited ASCII text spreadsheet file. Select 
the Export function from the Files menu and a window will 
open (Figure 3-6 Directory Selection) asking the user to select 
the directory or folder containing data files to be exported. 
Function Key Ctrl+E 

Set File Filter Limits the sort criteria when retrieving files.   

Save Setup Saves the current settings of the program to be recalled when the 
spectrometer is initialized.  The settings saved include the 
wavelength range, lamp crossover wavelength, the table of 
wavelengths to be monitored, current disk paths for data, 
precision setting, smoothing on/off and points, and the grid 
on/off. 

 
Print Graph Outputs the displayed spectrum, comments section and dataset to 
& Info the selected Windows output device.  Function Key Ctrl+P 

 
Print Only Outputs the displayed spectrum to the selected Windows output 

device. 
Graph  

 
Printer Setup Recalls the Windows printer setup dialog routine. 

 
Exit Closes the application. 
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Edit Menu 

 
Cut Cuts the selected information and copies 

it to the clipboard. 
 
Copy Copies the selected information to the 

clipboard. 
 
Paste Pastes the clipboard contents into 

application. 
 
Clear Deletes the current entry. 
 
Preferences Allows for customization of input/output path selection, PC 

memory allocation performance, display options and colors, 
printing margins, time and date formats. 



Software Overview 

30 

Operate 
 

Set Precision Allows users to select the desired 
level of precision and acquisition 
speed.  Available options are low, 
medium and high precision. 

 
Wavelength Allows users to select the desired 
Range  wavelength range and source lamp 
 crossover wavelength. 
 Key Function Ctrl + W 
 
Quantitative Opens the quantitative analysis 

feature.  Function Key Ctrl + Q 
 
Timed  Opens the timed Acquisition and  
Acquisition kinetics features.  Function Key Ctrl+T 
 
Initialize Established communication with spectrophotometer by utilizing 

information input through the Configure option.  This dialog is 
automatically executed during instrument power on after the SI 
400 Software Application has been selected. 
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View 
 

Multiple Spectra Opens the Multiple 
Spectrum Display 
feature allowing for the 
view of up to 10 spectra 
at once. from the View 
menu opens a new front 
panel to view up to 10 
spectrum at once.  

Auto Add  to  automatically places the newly acquired spectra into the 
Multiple Spectra  Multiple Spectrum Display feature. 
 Function Key Ctrl+M 
 
Restore Full View Displays original spectrum to full scale.  Function Key F3 or 

Ctrl + F 

Grid Allows user to add or remove the grid lines in the spectrum. 
Function Key Ctrl+G 
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Help 

Show Help Provides a description of 
each feature currently 
selected by moving the 
cursor over the selected 
item. 

An on-line help feature is available to explain the purpose 
and functions of the various controls and indicators on all 
front panels except the previously described controls 
associated with the graphical displays.  A help window is 
opened by selecting "show help" item from the Help item on 
the menu bar or with the key combination Ctrl + H.  The 
help window will contain a description of the control or 
indicator that the mouse cursor is currently over.  To view a 
description of a control or indicator, simply position the 
mouse cursor over the item of interest.   
 

About  Provides system information including software version, 
Spectrometer  spectrograph calibration coefficients and controller hardware. 
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Saving Files 
 
Save 
 
The most common way to save a current data file is to use the Save or Save As 
options from the File menu. Selecting the Save option will result in a typical 
Windows dialog box allowing users to select a specific file location for saving 
files. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Figure 3-2 :  Saving Data Files 

 
Current data files acquired using the Main Panel or Quantitative feature will be 
saved with the default *.SIS file extension.  This ensures data security as these 
files can only be accessed via the 400 Series software and cannot be altered.  
The displayed spectra, comments and data table contained on the screen will be 
saved to the designated folder.  Data files can be retrieved using the Open menu 
option. 
 
The hotkey option for saving data files is accessed using Function Key F7 or 
Ctrl+S. 

 
Data files acquired using the timed acquisition feature will be saved as a *.SID 
file format which cannot be altered as well. 
 
In addition, files having the *.SID file extension can only be accessed via the 
timed acquisition menu. 
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Save As 
 
Selecting the Save As option permits users to choose between text or Excel file 
formats for saving data files. Selecting either the Text or the Excel format will 
result in a different Windows dialog box allowing users to select either the *.TXT 
or *.XLS file extension formats.  These files cannot be opened in the SI400 
application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-3:  Saving Files in Text or Excel 
 
 
Data files that have been saved using either the *TXT or *.XLS file formats can 
be readily imported into various spreadsheet programs such as Excel and 
Quattro Pro as well as text recognition programs.   The *.TXT file extension is a 
comma delimited format. 
 
It should be noted that data files containing the *.TXT or *.XLS are editable and 
therefore the data content is not secure from manipulation or tampering. 
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Auto Save 
 
The Autosave feature allows users to automatically save each successive 
spectrum and dataset to a selected file in the *.SIS format.  Selecting the 
Autosave option will result in a new dialog box prompting the user to input a file 
name and select the appropriate folder for successive files to be saved to. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-4:  Auto Save Path Settings 
 
Depressing the Select Folder button will result in another dialog box allowing the 
user to select the appropriate folder and location.  Once the appropriate folder 
has been selected the user can chose the Select Current Directory button and 
all subsequent data files will be saved to the appropriate file location. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-5:  Selecting File Folder 
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Auto Save As 
 
The Auto Save As option allows users to automatically save a data file as the 
default *.SIS format or can be selected to save as *.TXT file extension.  
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Exporting Data 
 
Export 
 
Selecting the Export option from the File menu exports a single file or a group of 
files that have been saved on the disk to an Excel or delimited ASCII text 
spreadsheet file.  A new pop-up window will open prompting the user to select 
individual data files or a folder containing a group of files to be exported. In the 
active window choose individual files using the Shift key and right clicking the 
mouse button for individual files.   
 
To select an entire file for exporting, choose the Select New Folder button to 
designate the folder containing the data to be exported.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
 
 

Figure 3-6 :  The file list contains the files for export
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If the Select New Folder option was chosen, a new dialog window will appear 
prompting the user to select the desired folder.  Once the desired folder has been 
highlighted, the Select Cur Dir button located at the lower right of the dialog 
window should be selected.  This will return the user to the previous screen 
indicated in Figure 3-6.  The selected files will be indicated in the File List dialog 
box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3-7:  Selecting File Folder 
  
Once the appropriate data files are indicated in the File List dialog box, a new 
window opens and listing the selected files and allows the user to choose the 
type of data to export, the type of file format, and whether to smooth the data. 
 
 
 
 

 
  
 
 
 
 
 
 
 
 
 
 

 
Figure 3-8:  Selecting File Format
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The final window in the export dialog prompts the user to select the appropriate 
file format and destination.  The exported data must have the same wavelength 
range since the first column contains the wavelength values and each successive 
column contains data for each selected file.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 3-9:  Choosing Files to Save 

 
At this point the user can complete the export process by pressing the Save 
button, or Cancel the operation.  
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Peak Find 
 
The Peak Find feature is opened by pressing the button on the Main front panel.  
This feature is used to analyze the peaks and valleys of a spectrum and display 
the associated wavelengths and intensities. These values are also displayed in 
the Wavelength Table. A spectrum must have been taken or opened in the Main 
front panel before utilizing the Peak Find feature. 
 

 
 

Figure 4-1: Peak Find front panel 
 
The graphical display on the Peak Find front panel is used to present 
absorbance, transmission, reflectance or intensity as a function of wavelength.  
When the window is opened, the default representation will show the peaks of 
the spectrum.  To view the valleys of the spectrum, select the box in the lower 
right corner, and choose the valley option.
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Peak Find Front Panel Controls 

Close  Closes the Peak Find front 
panel and opens the Main front 
panel 

Film Thickness  Calculates the thickness of 
substrate in micrometers (um). 
The user must type in the 
refractive index of film being 
tested. This calculation is found 
under the peaks find table in the 
“No Calculation” menu. 

Find Peaks   Calculates the highest point in 
each peak, or lowest point in a 
valley, marks the spectrum and 
updates table up to 60 points.     
(Function Key F5)   

Peak Width   Used in the calculation of 
determining the peaks.  

 Peaks/Valleys  Toggle switch to change the 
display of peaks to valleys. 

Smoothing Smoothes the data that is 
displayed by a Savitzky-Golay 
quadratic-cubic algorithm with an 
adjustable number of points.  
This effectively increases the 
signal to noise ratio of spectral 
data at the expense of reduced 
spectral resolution.  Data saved 
to disk files is not saved in 
smoothed form, but any file read 
from disk can be smoothed.  The 
smoothing algorithm is described 
in J. Anal. Chem., 1964, 36, p. 
1627.   

Points Varies the number of points in 
the smoothing algorithm.  As the 
number of points is changed, the 
current spectrum displayed is 
dynamically updated with the 
new smoothing parameters. 
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On/Off Turns smoothing on or off.  
Only the currently displayed 
spectrum is affected.  Once 
smoothing has been turned on 
any subsequently acquired 
spectra, or data files read from 
disk will be automatically 
smoothed.   

Threshold The threshold cursor allows the 
manipulation of the peak find 
function to only show the peaks 
above the threshold cursor 
level. In valley analysis, only the 
troughs below the threshold 
cursor are displayed. The cursor 
movement is performed the 
same as the other two cursors.  
The default color for the 
threshold cursor is purple and is 
represented as a horizontal line 
in the graphical display. 

Y Scale Adjusts the y-axis to fit the 
spectrum to fill the full display.  

 

 

Cursor Status Displays the current cursor 
Indicator                  position with respect to                                             
                                 wavelength and intensity.  The   
                                 cursors are color coded for   
                                 clarity. 
 

 
 
 
 

 

Threshold 
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Multiple Spectra Overlay 
 
The Multiple Spectra Display is accessed through the View menu on the Main 
front panel and is used to see and manipulate up to 10 spectra at a time. To be 
displayed in this window, the spectra must have been acquired in the Main front 
panel or as saved disk files.  
 

 
 

Figure 4-2:   Multi Spectra Display front panel 
The spectra can be manually opened in the Multi Spectra Display window from 
saved files or they can be automatically transferred over by selecting the Auto 
Add to Multiple Spectra option in the Main front panel. This feature is on by 
default. As each spectrum is acquired and transferred to the Multi Spectra 
Display panel, the spectrum shift down the list. When more than 9 spectrum are 
opened or transferred, the spectrum are removed from the bottom. The tenth 
spectrum in the table is a reference cell and will not automatically be removed.  

The spectrum in the Multi Spectra Display front panel can be manipulated in 
simple mathematic functions such as adding, subtracting and multiplying. The 
arithmetic can be performed on the spectra with two spectra or a spectrum and a 
constant. The newly formed spectrum will transfer up to the number one 
spectrum cell in the table.
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Graphical Display 
 
The graphical display on the Multi Spectra Display front panel is used to present 
absorbance, transmission, reflectance or sample or blank intensity as a function 
of wavelength.  

The spectra displayed can be turned on and off by selecting the on/off button 
next to each spectrum. 
 

Controls 
The following is an alphabetical listing of Multi Spectra Display controls 

Blue Cursor - Adds an entry into the wavelength column of the data table at the 
current position of the blue cursor. 

Calculate – Performs the mathematical operation between the two selected 
spectra or spectra and a constant value.  

Clear Spectrum – Clears all or individual spectra from the spectra list.  

Clear Table - Clears the data table. 

Close – Closes the Multi Spectra Display panel and re-opens the Main front 
panel. 

Export Files - From the File menu exports a single file or a group of files that 
have been saved on the disk to an Excel spreadsheet file or a 
delimited ASCII text spreadsheet.  

File Name Filter - limits the sort criteria when retrieving files from the disk. 

Grid – From the View menu allows user to add or remove the grid lines in the 
spectra display.  

Info – Opens a new window to edit and review File Name and Comment section  

ON/OFF – Adds or removes the spectra from the display window 
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Figure 4-3:  Spectra Info Box 

Open File - Opens a data file created with the Save File menu item.  The 
spectrum in the data file, along with all other file information, is displayed.   

Open Multiple Files -Opens multiple data files saved on disk.  The 
spectrum in the data file, along with all other file 
information, is displayed. 

Select a Folder – Opens new window to selects a folder from 
which to open files. Click on Select Cur Dir to finish 
operation and return to Open Multiple Files window. 

Select Files – Click on individual files or use the shift key for 
multiple selections up to 9 spectra. To select a 
contiguous series of file names, shift + click and drag. 
Click OK to finish. 

Print Graph - Outputs spectrum only with legend 

Restore Full View – Rescales the image to the original settings.   

Save – Select the spectrum to be saved and edit comment section in the 
comment window. Click on Close and a save file window opens. Type 
in file name and click on Save. 

Set Reference – Selects which spectra in the table is to be used as a reference 
and transfers all data of the chosen spectra to the reference 
spectrum destination. To transfer a spectrum into the 
reference cell, the spectrum must be turned ON to come up in 
selection choices. 
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Smoothing - Smoothes the data that is displayed and that used for quantitative 
data analysis by a Savitzky-Golay quadratic-cubic algorithm with an 
adjustable number of points.  This effectively increases the signal to 
noise ratio of spectral data at the expense of reduced spectral 
resolution.  Data saved to disk files is not saved in smoothed form, 
but any file read from disk can be smoothed.  The smoothing 
algorithm is described in J. Anal. Chem., 1964, 36, p. 1627.   

On/Off - Turns smoothing on or off.  Only the currently displayed spectrum 
is affected.  Once smoothing has been turned on any 
subsequently acquired spectra, or data files read from disk will be 
automatically smoothed.   

Points - Varies the number of points in the smoothing algorithm.  As the 
number of points is changed, the current spectrum displayed is 
dynamically updated with the new smoothing parameters.   

 

Update Table - Updates the absorbance, % transmission, % reflectance or 
intensity fields in the data table.  Used when wavelengths are 
manually entered in the data table rather than using the blue 
cursor/red cursor buttons.  

View All – From the view menu, turns all spectra in the table to the ON position, 
displaying all spectra. 

Y Scale – Adjusts the y-axis to fit the spectrum to fill the full display 
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Quantitative Analysis 
 
Quantitative Analysis Front Panel 
 
The Quantitative Analysis feature is accessed via the Operate menu on the 
Main Panel.  Before opening the Quantitative Analysis front panel, it is best to 
take a blank spectrum and a sample spectrum of a standard solution to facilitate 
the choosing of analysis wavelengths. 
 
Controls are available to acquire data from standards and unknowns, fit 
standards data to a calibration curve, and determine concentrations of unknowns 
based on the calibration curve data.  The Quantitative Analysis front panel has 
a graphical display for analytical data and a calibration curve, a section for 
controls and data related to analytical standards and a section for controls and 
data related to unknowns. 
 
 

 
Figure 4-4:  Quantitative Front Panel 
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Standards and Unknowns Tables 

The standard number and concentrations for each standard are entered in the 
Standards Table.  The absorbance for the standards at the analytical 
wavelengths and the confirmation wavelengths will automatically be entered into 
the rest of the table when the Acquire Standard button is pressed.  

Description for the unknowns is entered in the Unknowns table.  Concentration 
and absorbance results will be calculated and inserted when the Acquire 
Unknown button is pressed.  

 

Graphical Display 

The Graphical Display on the Quantitative Analysis front panel is used to 
present absorbance as a function of concentration information. Data from the 
analytical wavelength, or confirmation wavelengths, can be viewed directly from 
the graphical display as well as the tables. 

The Graphical Display contains many of the control features as indicated on the 
Main Panel for your convenience in viewing your data. 

 

Comment and File Name Dialog Boxes 

The upper right corner of the Quantitative Analysis front panel contains many of 
the same user dialog entries as indicated on the Main Panel.  These entries allow 
the user to specify comments, user name and file name. 
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Quantitative Analysis Procedures 

Once the Quantitative window is open, the procedure for performing quantitative 
analyses is as follows: 

Select the Operate menu option and choose Selected Wavelengths.  The 
Quantitative Wavelengths Selection menu will allow for the selection of the 
wavelengths to be used for analysis.  
 

 
Figure 4-5: Quantitative Wavelengths Selection Menu 

 
The Analytical Wavelength is usually the wavelength of maximum absorbance 
for the sample.   

The Reference Wavelength is usually a point of minimum absorbance for the 
sample.  When a Reference Wavelength is selected true background correction 
is available. The absorbance at this wavelength is automatically subtracted from 
the absorbance at the Analytical Wavelength during the computations in the 
Quantitative Analysis front panel.  This is a substantial feature not available on 
scanning instruments. 

The Confirmation wavelengths are typically used for tests of purity or chemical 
interference in a sample.  The wavelength is usually chosen in a region of 
appreciable absorbance, but removed from the Analytical Wavelength. 

The selection of analytical, reference, and confirmation wavelengths may be 
made by typing in the value into the appropriate box.  An alternate method is to 
position a cursor at the desired location on the spectrum in the graphical display.  
Select Analytical, Reference, Confirmation 1, or Confirmation 2 on the 
Wavelength Selection control box and press the Blue Cursor or Red Cursor 
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button depending on which cursor is being used.  The wavelength of the cursor is 
entered into the selected item.  A spectrum of an analytical standard must be 
acquired in the Main front panel to use the graphical input approach.   

Each type of wavelength must be turned On in order to be incorporated into the 
quantitative calculations. 

1. There is an option to acquire a new blank spectrum if it is deemed necessary.  
Press the Unlock Blank button to make the Blank button active and proceed 
with taking a new blank.  After the blank is acquired, the Blank button is 
automatically locked to lessen the chance of it inadvertently being pressed.  

2. Enter the concentrations of the standards into the Standards Table.  If there 
are more than ten standards, a scroll bar will appear on the right side of the 
table to allow the table to be scrolled down. 

3. Next, acquire the spectra for the standards.   When the Acquire button for 
standards is pressed, the data will be put into the table for the standard 
number indicated in the Standard Number control.  This control defaults to 1 
and will automatically increment to the next standard number.  This control 
can also be used to manually set the next standard number to be acquired. 

4. When all the standards have been acquired, select the Calibrate item in the 
Operate menu and the calibration curve (linear least squares fit) for the data 
will be calculated and displayed on the Graphical Display.  At this point, the 
fit results can be viewed by pressing the View Fit Results option in the 
Operate menu. 

5. Now you are ready to measure the concentration of unknown samples.  
Prepare the first unknown sample to be measured.  A description can be 
typed into the unknown table in the Name column.  The Unknown Number 
control selects the unknown number in the Unknowns Table for which data 
will be collected.  This control is initially set to 1 and will automatically set to 
increment to the next number after a new spectrum is acquired.  Data is 
acquired by pressing the unknown Acquire button and the results will appear 
in the Unknowns Table.  There are scrollbars on this table for both vertical 
and horizontal movement.  The horizontal scrollbar allows viewing of the 
results for the Confirmation Wavelengths.  
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Quantitative Front Panel Controls 

Acquire  Two Acquire buttons are present, one in the 
standards section and the other in the 
unknowns section.  These buttons acquire a 
spectrum for the data tables they are adjacent 
to.  The standard and unknown numbers are 
chosen before the acquisition, then data is 
stored in the corresponding line in the table.  
For the standards Acquire button, the known 
concentration must be entered before taking 
the spectrum.  

NOTE:  Analytical, reference and confirmation 
wavelengths must be set before the button is 
active.  See Wavelength Selection. 

Function Key Acquire Standards F1 

Function Key Acquire Unknowns F6 

 

Blank Acquires and stores spectrum of blank sample 
for calculation of absorbance and % 
transmission relative to sample spectrum.  Data 
is stored until the wavelength range is changed 
or a new blank is acquired. 

 

 

Select Wavelengths  Located in the Operate menu, 
this option opens a new front 
panel that displays a graph of a 
spectrum for the selection of 
analytical, reference and 
confirmation wavelengths for the 
quantitative analysis front panel.  

 

 

Calibrate  Found in the Operate menu calculates the best fit function to 
standards data using linear regression. 
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View Fit Results Displays statistical data from linear regression for 
Analytical and Confirmation wavelengths and is found in 
the Operate menu. 

Clear Standards Clears all information entered into the Standards Table 
and accessed from the Operate menu. 

Clear Unknowns Clears all information entered into the Unknowns Table 
and accessed from the Operate 
menu. 

Close Closes the Quantitative front panel and opens 
the Main front panel.  Data in the Quantitative 
front panel will not be lost. 

Concentration units 

Molarity Data units displayed as molarity (mol/L). 

PPM Data units displayed as parts per million 
(ppm or mg/L).   

 

Format Sets the display preferences for 
concentration values.  The units may be 
decimal, scientific or engineering.  Number 
of decimal places displayed is also set 
here.     Function Key F11 

 

 

 

 

Spectrum Found under the View menu displays a spectrum at full screen size 
of the most recent spectra acquired. 

Standard number Changes the line number where data 
is inserted in the Standards Table 
when Acquire button is pressed.  
This number will automatically 
increment by one after each sample. 
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Unknown number Changes the line number where data is 
inserted in the Unknowns Table when 
Acquire button is pressed.  This number 
will automatically increment by one after 
each sample. 

Unk. Conf.  Used to set the acceptable percent 
difference between analytical and 
confirmation concentration.  A 
warning will be displayed if 
unknown concentration is out of 
tolerance. 

Unlock Blank  This button will enable/disable the Blank 
button.  This prevents accidental acquisition 
of a new blank. 
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Quantitative Wavelengths Front Panel Controls 

 
 

Analytical Wavelength Is a control where the analytical 
wavelength can be directly 
entered from the keyboard.  
There is also an on/off control to 
enable or disable the use of the 
analytical wavelength in the 
quantitative front panel.   

Blue Cursor Enters the wavelength into the selected 
control box (see Wavelength selection) at 
current position of the blue cursor.  

Close Closes the Analytical Wavelengths window 
and brings back the Quantitative screen. 

Confirmation Wavelengths       A control where 
the confirmation wavelengths can 
be directly entered from the 
keyboard.  There is also an on/off 
control to enable or disable the use 
of confirmation wavelengths in the 
quantitative front panel.  
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Red Cursor  Enters the wavelength into the selected 
control box (see Wavelength selection) at 
current position of the red cursor.  

 

Reference Wavelength Is a control where the reference 
wavelength can be directly 
entered from the keyboard.  
There is also an on/off control to 
enable or disable the use of a 
reference wavelength in the 
quantitative front panel.   

 

Wavelength Selection Determines which wavelength 
type will be recorded when the 
Red Cursor or Blue Cursor 
button is pushed.  Selections 
are: 
 Analytical 

 Reference 
 Confirmation 1 

 Confirmation
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Timed Acquisition 
The Timed Acquisition front panel is accessed by going through the Operate 
menu of the Main front panel and is used to acquire spectral information at fixed 
time intervals.  The wavelength range over which spectra will be acquired must 
have been previously set using the wavelength range item on the Main front 
panel’s Operate menu.   

The Timed Acquisition front panel has a graphical display similar to the one on 
the Main front panel.  An acquisition mode selector allows the selection of full 
spectrum acquisition, or discrete wavelengths.   

Figure 4-6:  Timed Acquisition, Full Spectrum Mode 
 
In full spectrum mode, the spectra are automatically 
saved either as text files or in SI400 format as the user 
selects.  The naming and path for saving the spectra is 
specified in the acquisition setup covered below.  
Opening and printing a spectrum taken with timed 
acquisition is performed in the Main front panel.
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Figure 4-7:  Timed Acquisition Setup Full Spectrum Mode 
Multiple spectrum files are saved using a data series name, followed by an 
incremented number, followed by the .SIS extension. Example: Data Series 
TEST.SIS.  The data series name is entered in the Data Series dialog box while 
the Start at # control box selects the beginning number in the series. 

The Select Folder button opens a dialog box to choose the folder where the 
spectra will be saved.  Once a folder is selected, click on Select Cur Dir button 
to return back to the set-up box. 

 

 
 
 
 
 
 
 
 
 

 
Figure 4-8:  Set path dialog box 
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Figure 4-9:  Time Acquisition, Discrete Wavelengths Mode 

In discrete wavelength mode, a table appears displaying 
the wavelengths to be monitored, along with a color 
assignment for that wavelength as it is plotted on the 
graphical display.  Data acquired at discrete wavelengths 
can be viewed graphically as changes in absorbance or 
transmission as a function of time.  As many as ten discrete 
wavelengths can be simultaneously monitored. 

 

 

 

  

 

 

 

Figure 4-10:  Discrete Wavelengths with Manual Save Selected 
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In the discrete wavelength mode, the parameters to be chosen are the time 
interval between acquisitions, number of acquisitions, and the wavelengths to be 
acquired.  Up to ten wavelengths can be chosen.  Any wavelength set to zero will 
be ignored.   

 

Figure 4-11: Discrete Wavelength Setup with Continuous Saving Selected 

In this mode, only the values at the chosen wavelengths are saved.  If the 
Saving Mode is set to Manual, no Select Folder button is present, as the data 
for the discrete wavelength acquisition will be saved manually at the end of the 
run with the Save to File button in the Timed Acquisition panel.  When set to 
Continuous as indicated above, the Select Folder button is present and the file 
path is set in a dialog box.  In this mode, the data is saved to the same file after 
each spectrum is taken.  This is useful when doing long time acquisition so the 
data is not lost if there is a computer problem or power failure. Files saved as 
discrete can only be opened in the Time Acquisition window. 

An assortment of controls for saving, opening, and printing data files similar to 
that found in the discussion of the Main front panel appear on the Timed 
Acquisition front panel.  Files from data acquired in the discrete wavelength 
mode are incompatible with those acquired using the full spectrum mode, and 
can only be viewed from the Timed Acquisition front panel.  There is an 
additional command on the discrete wavelengths mode panel for kinetics that is 
described below.  
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Timed Acquisition Front Panel Controls 

The following is a listing of the Timed Acquisition front panel controls.   

 

Close  Closes the Timed Acquisition front panel and 
opens the Main front panel.  

 

File Menu 

Open  Retrieves a data file from the disk 
that was previously saved.  

Save  Saves the displayed data and 
comments shown on screen to 
disk.  Data is retrieved with the 
Open command.  The file format is 
compatible with the SI400 
application only.  

Save as Text                                            
From the File menu saves data as an ASCII tab delineated 
file for export to spreadsheets and data manipulation 
programs. 

Save as Excel                                                                                  
From the File menu saves data as an Excel spreadsheet file 
for export later to perform data manipulations 

Set File Filter                                                                                
Limits sort criteria when retrieving files and is accessed from 
the File menu.  

Print  Graph                                                                                    
Outputs data in the graph, comments section, and 
wavelengths displayed on the screen to selected output 
device. 
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Printer Setup                                                                                       
Opens a dialog box where a number of setup parameters 
are selected.  The dialog box changes depending upon 
which mode (full spectrum or discrete wavelengths) is 
chosen.  In full spectrum mode, the dialog box allows 
selection of the time interval between acquisitions, number 
of acquisitions, and the file information, and specific 
wavelengths of interest.  The full spectrum is saved and if 
any wavelengths are entered into the Wavelength table, 
these wavelengths are also saved with the spectrum.  When 
the spectrum is opened in the Main front panel, the values at 
those wavelengths will be displayed in the wavelength table 
on the Main front panel. 

Time Remaining   Shows the amount of time 
remaining to complete the 
data acquisition.  

Time Until Next Acq.  This indicator displays 
the time remaining until 
the next acquisition will 
take place. 

Samples Taken This indicator shows the 
number of data acquisitions 
completed.  This number is 
updated as acquisitions are 
made.   

Start Pressing this button starts acquisition for either full 
spectrum or discrete wavelength mode. 
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Kinetics  

Selected from the Operate menu, the Kinetics front panel allows the viewing of 
discrete wavelength data as a kinetic plot of raw data or a first order plot with rate 
constants for each wavelength measured.  There is also an option to limit the plot 
display and rate calculations between two cursors. 

 

Figure 4-12: Kinetics front panel
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Troubleshooting 

Error Messages 
If initialization is not successful, one of three error messages will appear in dialog 
boxes.  The first possible error message is: 

Error 37 occurred In Com Port Init.VI: 

The selected COM port either does not exist or is in use by another 
application.  Press the CONFIGURE button to select another COM 
port.  Refer to user's manual for more information. 

Possible reasons:  

LabVIEW: Device not found. 

The SI400 control application could not find the COM port you specified during 
configuration.  The COM port may physically exist or not, but it could not be 
"found" through the Windows operating system.  If another Windows application 
is open which may be using the COM port, close the application.  If you are sure 
that the COM port physically exists, make sure that Windows knows of its 
presence.  For Windows 95 and higher, a good way to start troubleshooting this 
problem is to open the System application in the Control Panel and look under 
Device Manager, Ports, for the COM ports that are available.   

The second error message that can occur is: 

Error -1201 Occurred 

Spectrometer Initialization. 

Series 400 spectrophotometer is not responding to initialization 
command.  Verify that spectrophotometer power is switched on, and 
that the communications cable is connected. 

This will arise if the communications port is found on the host computer end, but 
there is no response from the 400 Series Spectrophotometer when information is 
sent to it.  Make sure that the RS-232 cable is plugged into the spectrometer, and 
to the port that you specified during configuration.  Also, make sure that the 
communications cable has no broken conductors.  The 9 pin D male to 9 pin D 
female connector cable supplied with the 400 series instruments is wired straight 
through with pin 1 connecting to pin 1, pin 2 to pin 2, etc.   
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A third message that can appear is: 

Error -1202 Occurred 

Spectrometer Init.VI.  

An error has occurred while transmitting the initialization file to the 
series 400 spectrometer.  A likely cause is a mismatch in the 
communications data rate (baud rate) settings.  The computer port 
baud rate must match the spectrometer baud rate.  The computer 
baud rate is changed using the CONFIGURE button on the main 
program screen.  Refer to user's manual for information about the 
spectrometer baud rate. 

If the COM port baud rate is correct, check the integrity of the 
communications cable. 

This error indicates that while there was a response from the spectrophotometer, 
it was not the expected one.  In addition to checking baud rates, make sure that 
the COM port selection is correct.  If the SI400 application is trying to 
communicate with the spectrophotometer on a serial port that another device 
(such as a mouse or modem) is connected, this error can result.  It is also 
necessary that the COM port being used is not sharing an interrupt (IRQ) with 
another COM port or modem. 

This error can also occur if the cable between the host computer and the 
spectrophotometer is too long, or is being used in an electrically noisy 
environment, or is not properly shielded.  If it is necessary to use a long cable, try 
to reduce the baud rate to 9,600.  

Sometimes it is necessary to set the serial transmit buffer to Low in Windows 95.  
This is performed in the System Properties window launched from the Control 
Panel.  Select the Device Manager tab; expand the Ports (COM & LPT) item; 
double click on the COM port being used to display its properties.  Next select 
the Port Settings tab and then press the Advanced button to open the 
Advanced Port Settings window.  Here there are two controls, one for Receive 
Buffer and one for Transmit Buffer.  The Receive Buffer is normally set near High 
and should be left this way.  The Transmit buffer needs to be set to Low for the 
most reliable communications. 
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Unreliable Communications  

Unreliable communications can result from a number of sources, including the 
computers RS-232 port, cable, and software drivers.  One of the primary sources 
of problems is slow computer response time that is related to how many tasks 
the Windows task scheduler has in its queue.  If the system can not respond to 
the serial communications port sufficiently fast, characters may be occasionally 
and unpredictably dropped, resulting in errors during the spectrophotometer 
initialization. 

The use of a buffered serial interface port equipped with 16550 UARTs is 
required, as it will collect characters internally while waiting for service from the 
computer's processor.  The older 8250 type UARTs has no internal buffer, and 
will not work reliably.  The type of UART used in a serial port can be determined 
using the DOS 6.22 "MSD" command.   

The use of 16550 UART equipped serial ports and high quality RS-232 cables 
will result in reliable communications in nearly every situation. If communications 
problems persist, contact Spectral Instrument's service department for assistance 
with other solutions. 

It has been found that on some notebook computers that it is necessary to turn 
off the power management to obtain reliable communications.  This is due to the 
overhead added to the system by the power management causing some 
communications to be lost. 

 

Screen Size 
 
The programs front panels are designed for use with at least 800 x 600 resolution 
on the Windows display.  If the display is set to 640 x 480, parts of the front panel 
will be off the screen and it is necessary to change the resolution of the display.  
See the Windows manual or Help screens for the procedure to change the 
display resolution. 

 

Lamp Intensity Warning Messages 
 
Figure 5-1 shows what a normal Blank intensity spectrum looks like.  This 
spectrum will vary from one spectrometer to another and depending on where 
the crossover wavelength for the UV and visible lamps is set.  Here the crossover 
is at 460 nm and is not optimized.
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Figure 5-1:  Normal Blank intensity spectrum 

High Lamp Intensity 
 
The SI400 application will alert the user if the tungsten lamp intensity is too high 
when a blank is acquired by giving the warning message: 

The Tungsten source intensity is too HIGH 
and must be adjusted.  See the manual for 
instructions.   

A similar message will result from high deuterium lamp intensity.  The user may 
choose to either cancel the operation or continue by pressing the appropriate 
buttons in the dialog box.   

If either warning message occurs, turning the intensity adjustment screw 
clockwise should reduce the appropriate lamp intensity (see Section 2.4).  

 

Low Lamp Intensity 
 
If the light intensity reaching the detector from the tungsten lamp is very low, the 
warning message: 

The Tungsten source intensity is too LOW 
and may need to be adjusted or the lamp 
is out.  See the manual for instructions. 

will appear.  A similar message results from a low deuterium lamp intensity.  
Again, the user may cancel or continue by pressing the appropriate button.   
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A low intensity means that the spectrophotometer has determined that even by 
increasing the readout integration time to a maximum (10 seconds for both 
tungsten and deuterium sources using "normal" precision), the intensity of light 
reaching the detector is so low that an unacceptable signal to noise may result.   

Light may not reach the detector due to: 

1) A lamp is not functioning. 

2) The fiber optic probe is not installed, not sampling a blank, or very 
inefficient or defective. 

3) Lamp intensity adjustment screw is blocking too much light.   

Check each item above in the order listed.  Adjust the lamp intensity as 
described in Section 2.4. 
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